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EXPERIMENT 1 - BASIC C# PROGRAMS

&To understand about basics of C# and execute simple c# programs to perform the following actions:
(a) Calculate Hypotenuse of triangle using dynamic initialization of variables
(b) To get input from the user and perform calculations
(c) Calculate the quadrant for the coordinates using if..clse...ladder
(d) Check whether the alphabet is a vowel or not using switch..case...
(e) To understand about for..each loop and strings
ALGORITHM

Step 1: Open Visual Studio Express edition 2010

Step 2: Click File->New project->Select C# under installed tab and select console application
Step 3: Give name for your application and click OK

Step 4: Give any class name and declare variables and write methods

Step 5: Create objects for classes to execute methods

Step 6: Click save and click run button for execution

PROGRAMS:
(a) Hypotenuse of triangle:

class DynlInit
{
static void Main()
{
/I Length of sides.
double s1 =4.0;
double s2 = 5.0;

/I dynamically initialize hypotenuse

double hypot = Math.Sqrt( (s1 * s1) + (s2 * s2) );

Console.Write("Hypotenuse of triangle with sides " + s1 + " by " +s2 +"is");
Console.WriteLine("{0:#.###}.", hypot); //format to display using 3 decimal values
Console.Readkey();

}

}

(b) To get input from the user and perform calculations

class Program

{

static void Main(string[] args)

{




Console.Write("Enter a number: *);
int num1 = Convert.Tolnt32(Console.ReadLine());

Console.Write("Enter another number: *);
int num2 = Convert.Tolnt32(Console.ReadLine());

Console.WriteLine("{0} + {1} = {2}", num1, num2, num1 + num2);
Console.WriteLine("{0} - {1} = {2}", num1, num2, num1 - num2);
Console.WriteLine("{0} x {1} = {2}", num1, num2, num1 * num2);
Console.WriteLine("{0} / {1} = {2}", num1, num2, num1 / num2);
Console.WriteLine("{0} mod {1} = {2}", num1, num2, num1 % num2);
Console.ReadKey();

¥

(c) Calculate the guadrant for the coordinates using if..else ladder
class Program

{

static void Main(string[] args)

{

int col, co2;

Console.Write("\n\n");

Console.Write("Find the quadrant in which the coordinate point lies:\n");
Console.Write("'------==mmmmmmm oo oo ");
Console.Write("\n\n");

Console.Write("Input the value for X coordinate :");
col = Convert.ToInt32(Console.ReadLine());
Console.Write("Input the value for Y coordinate :");
co2 = Convert.ToInt32(Console.ReadLine());

if (col >0 && co2 > 0)
Console.Write("The coordinate point ({0} {1}) lies in the First quandrant.\n\n",
col, co2);
else if (col <0 && co2 > 0)
Console.Write("The coordinate point ({0} {1}) lies in the Second
guandrant.\n\n", col, co02);
else if (col <0 && co2 <0)
Console.Write("The coordinate point ({0} {1}) lies in the Third
quandrant.\n\n", col, co2);
else if (col >0 && c02 < 0)
Console.Write("The coordinate point ({0} {1}) lies in the Fourth
quandrant.\n\n", col, co2);
else if (col == 0 && co2 ==0)
Console.Write("The coordinate point ({0} {1}) lies at the origin.\n\n", col, co2);

Console.ReadKey();
}

(d) Check whether the alphabet is a vowel or not using switch..case...
class Program

{

static void Main(string[] args)




char ch;

Console.Write("\n\n");

Console.Write(""check whether the input alphabet is a vowel or not:\n");
Console. Write("'---=-=====mmmmmmm oo oo oo e ");
Console.Write("\n\n");

Console.Write("Input an Alphabet (A-Z or a-z) : ");

ch = Convert.ToChar(Console.ReadLine(). ToLower());
inti=ch;

if (i>=48 && i <=57)

{

Console.Write("You entered a number, Please enter an alphabet.");

}

else

switch (ch)
{

case 'a"
Console.WriteLine("The Alphabet is vowel™);
break;

case 'i":
Console.WriteLine("The Alphabet is vowel");
break;

case '0":
Console.WriteLine("The Alphabet is vowel™);
break;

case 'u':
Console.WriteLine("The Alphabet is vowel");
break;

case 'e"
Console.WriteLine("The Alphabet is vowel");
break;

default:
Console.WriteLine("The Alphabet is a consonant™);
break;

ky

}
Console.ReadKey();

(e) To understand about for..each loop and strings
/lprint the length of the string without using library functions
class Program

{

static void Main(string[] args)
{
string str; /* Declares a string of size 100 */
int length= 0;
Console.Write("\n\nFind the length of a string :\n");
Console.Write("------=--=========nmmmmmmmmmmmoo- \n");
Console.Write("Input the string : ™);
str = Console.ReadLine();




foreach(char chr in str)

{

}
Console.Write("Length of the string is : {0}\n\n", length);

Console.ReadKey();
}

length+=1;

OUTPUT
(a) Hypotenuse

B filet/f/e/users/bist/documents/visual studie 2012/Projects/|abexla/labexla/bin/Debug/labexla.EXE |£|E‘£_hj

Hypotenuse of triangle with sides 4 hy 5 iz 6.483.

==

(b) Get input and perform calculations

B filey/ffc/users/bist/documents/visual studio 2012/Projects/labexlaflabexla/bin/Debug/labexla.EXE |£‘£_h]

Enter a numher: 5
« another number: 6

Soononn
Sw |
=

( ¢) Coordinates and Quadrant

Quadrant in which
the coordinate point lies

2nd Quadrant 5. 1st Quadrant
40——————1-—-E3:4]
A
34 !
I
e 1] |
I
" |
o 2 { 4 5

3rd Quadrant . 4th Quadrant
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1 file:ffic:fusers/bist/documentsfvisual studic 2012/Projects/labexla/labexla/bin/Debug/labexla.EXE |E|E|£_hj

Find the gquadrant in which the coordinate point lies:

Input the value for ¥ coordinate

Input the value for Y coordinate :—4
The coordinate point <3 —4) lies in the Fourth guandrant.

(c) Check the alphabet

r

B fileyffc/users/bist/documents/visual studie 2012/Projects/labexla/labexla/bin/Debug/labexla.EXE |E|E|_E_hl

check whether the input alphabet is a vowel or not:

Input an Alphabet (A-Z or a—z=>
The Alphahet iz a consonant

(e) Strings & foreach loop

B fileyffcfusers/bist/documents/visual studio 2012/Projects/labexla/labexla/bin/Debug/labexla.EXE |iﬂlﬁ

Input the string = dotnet laboratory
Length of the string iz : 17

Result:

Thus the program in C# programs is executed successfully and the output is verified
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EXPERIMENT 2— CLASSES & OBJECTS

Al

To develop a C# application to print the students list using classes and objects

ALGORITHM
1) Open Visual Studio Express 2010

2) Create a new project - select visual c# - console application - give any name - Ok
3) Create a class and declare necessary array variables

4) Create an object for the class and using for loop iterate it and get inout from the user to feed student
details

5) Display the student details
6) Save and execute the program

PROGRAM
using System;
namespace ConsoleApplicationl

{

class Student

{

public int[] studid = new int[5];
public int[] day = new int[5];
public int[] month = new int[5];
public int[] year = new int[5];
public string[] name = new string[5];
public string[] cname = new string[5];
public void details()

{

Console.WriteLine("Implementation of Classes and Objects ");

Conso I e. erte LI ne("**************************************")

Console.WriteLine("Enter students details and you can view those details");

Console.WriteLine("------=-====-=-===mmm e oo ");
}
class Ex2
{
static void Main(string[] args)
{
Student s = new Student();
s.details();
inti;
for (I=0;1<5;i++)
{

Console.Write("Enter Student I1d:");

s.studid[i] = Convert.ToInt32(Console.ReadLine());
Console.Write("Enter Student name : ");

s.name[i] = Console.ReadLine();

12




Console.Write("Enter Course name : ");
s.cname[i] = Console.ReadLine();
Console.Write("Enter date of birth\n Enter day(1-31):");
s.day[i] = Convert.ToInt32(Console.ReadLine());
Console.Write("Enter month(1-12):");
s.month[i] = Convert.ToInt32(Console.ReadLine());
Console.Write("Enter year:");
s.year[i] = Convert.ToInt32(Console.ReadLine());
}
Console.WriteLine("\n\nStudent's List\n");
for (i=0;i<5;i++)
{
Console.WriteLine("\nStudent ID : " + s.studid[i]);
Console.WriteLine("\nStudent name : " + s.name[i]);
Console.WriteLine("\nCourse name : " + s.cname[i]);
Console.WriteLine("\nDate of birth(dd-mm-yy) : " + s.day[i] + "-" + s.month[i] + "-" +
s.year[i]);
Console.ReadKey();

il S SR
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OQutput:
0 file/fcfusers/bist/documents/visual studi... |££|th

Enter Student Id:181

Enter Student name : Ahirami

Enter Course name : BCSH

Enter date of hirth

Enter dayii-31>:2

Enter month{1-12>:3

Enter year:1798

Enter Student Id:182

Enter Student name = Arun
Coursze name = BCH
date of hirth

Enter day<i-31>:3

Enter month{1-12>:4

Enter year:1778

Enter Student Id:183

Enter Student name : janani

Enter Course name : MBA

Enter date of hirth

Enter day{i-313>:29

Enter month{1-12>:3

Enter year:1991

Enter Student Id:184

Enter Student name : Ram

Enter Course name : MBA

Enter date of hirth

Enter day{i-313>:23

Enter month{1-12>:11

Enter year:1991

Enter Student Id:185

Enter Student name : Priva
Coursze name = MBA
date of hirth

Enter day<i-313:38

Enter month{1-12>:6

Enter vear:19778

Student’s List

Student ID :@ 181

Student name : Abirami

14




0 file:/f{c/users/bist/documents/visual studio 2012/Projects/ConsoleApplicationl/ConscleApplicati... | =aaon X

Enter Course name = MBA
Enter date of hirth
Enter day¢l-31>:23
Enter month{1-12>:11
Enter year:1991

Enter Student Id:185
Enter Student name : Priva
Enter Course name = MBA
Enter date of hirth
Enter day(1-31>:38
Enter month{1-12>:6
Enter year:19298

Student’s List

Student ID = 161
Student name : Abirami
Course name : BCS

Date of hirth{dd-mm-yy>
Student ID = 162
Student name : Aru
Course name :@ BCA

Date of birth{dd-mm-yy)
Student ID = 183

Student name : janani

Course name :@ MBA

Date of bhirth{(dd-mm-yy> 29-3-1991
Student ID = 1684

Student name : Ham

Course name : MBA

Date of hirth{dd-mm-yy> 23-11-1991
Student ID = 1B%

Student name : Priya

Course name : MBA

Date of birth{dd-mm-yy) 38-6-1990

Result:

Thus the program in C# for classes and objects is executed successfully and the output is verified
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EXPERIMENT 3(a) — INHERITANCE

Al

To develop a C# application to implement inheritance concepts
(@) Single Inheritance

(b) Multilevel Inheritance
(c) Multiple Inheritance

ALGORITHM (a)
1. Open Visual Studio Express 2010

2. Create a new project - select visual c# > console application - give any name - Ok
3. Create a class name Rectangle and declare necessary variables and methods
4. Create a subclass named Tabletop to inherit Rectangle class

5. Create another class named Execute Rectangle and create objects for derived class and execute the
methods

6. Save and execute the program

PROGRAM
(@) Single Inheritance
using System;
using System.Collections.Generic;
using System.Ling;
using System.Text;
namespace ConsoleApplicationl

{

class Rectangle

{
protected double length,width;

public void getdata()
{

Console.WriteLine("Enter the length and width of the rectangle!!");
length = Convert. ToDouble(Console.ReadLine());
width = Convert.ToDouble(Console.ReadLine());

}
public double GetArea()
{

¥
public void Display()

{

return length * width;

Console.WriteLine(""Length: {0}", length);
Console.WriteLine("Width: {0}", width);
Console.WriteLine("Area: {0}", GetArea());
}
}/end class Rectangle
16




class Tabletop : Rectangle

{

private double cost;

public double GetCost()
{

double cost;
cost = GetArea() * 70;
return cost;

¥
public void Display()

base.Display();
Console.WriteLine("Cost: {0}", GetCost());

k
¥
class ExecuteRectangle

{

static void Main(string[] args)
{
Tabletop t = new Tabletop();
t.getdata();
t.Display();
Console.ReadKey();

Enter the length and width of the rectangle??

16

2

Length: 18
Width:= 2

17




Ex-3-B MULTILEVEL INHERITANCE

ALGORITHM (b)
1) Open Visual Studio Express 2010

2) Create a new project - select visual c# - console application - give any name - Ok

3) Create a class name “Person” and declare necessary variables and methods

4) Create a subclass named “Student” to inherit Person class

5) Create another subclass named “Details” to inherit from Student

6) Create a class named “TestClass” and create objects for derived class and execute the methods

7) Save and execute the program

PROGRAM:
namespace ConsoleApplicationl

public class Person
{
protected string regno, name;
public void get()
{
Console.WriteLine("Multilevel Inheritance!™);
Console.WriteLine("Enter the register number and name of a student :-");
regno = Console.ReadLine();
name = Console.ReadLine();

¥

public virtual void display()
{

Console.WriteLine("Student register number - {0} and name is {1}", regno, name);
Console.ReadLine();

¥

class Student : Person

{
public string Classincharge = "Mr.ABC";
public override void display()

base.display();
Console.WriteLine("Class incharge of the Student is: {0}", Classincharge);
}
}
class Details : Student
{
private string StudentAddress = "BIHER Hostel, Chennai*;
public void display()
{

Console.WriteLine("Student Address: {0}", StudentAddress);
18




¥
¥

class TestClass

{
public static void Main()

{
Student s = new Student();
s.get();
s.display();
Details d = new Details();

d.display();
Console.ReadKey();

3
OUTPUT:

B file:///c:/users/bist/documents/visual studio 2012/Projects/Consclefpplicationl/ConscleApplicati.. | = =) 2

Multilevel Inheritance?

Enter the regizter number and name of a student -
SPCSENASK

S .PRIYA

Ctudent register number — SPCSEBSE6 and name is S.PRIYA

Clas=s incharge of the Student is: Mr.ABC
Student Address: BIHER Hostel. Chennai

19




Ex-3-C MULTIPLE INHERITANCE

ALGORITHM (c)

1) Open Visual Studio Express 2010

2) Create a new project > select visual c# > console application - give any name - Ok
3) Create a class named “Shape” and declare necessary variables and methods

4) Create an interface named “PaintCost” to declare methods for classes

5) Create a subclass named “Rectangle” to inherit from Shape class and interface

6) Create a class named “Test” and create objects for derived class and execute the methods
7) Save and execute the program

PROGRAM:

namespace ConsoleApplication2

{

class Shape

{
protected int width,height;

public void setWidth(int w)
{

}
public void setHeight(int h)

{
¥
¥

public interface PaintCost / /interface declarations

{
¥

/I Derived class inherits shape class & interface
class Rectangle : Shape, PaintCost

{
public int getArea()
{

}
public int getCost(int area)

{

¥
¥

class Test

{

width = w;

height = h;

int getCost(int area);

return (width * height);

return area * 70;

20




static void Main(string[] args)

{

Rectangle Rect = new Rectangle();
int area;

Rect.setWidth(5);
Rect.setHeight(7);

area = Rect.getArea();

Console.WriteLine("\t \t IMPLEMENTATION OF MULTIPLE INHERITANCE \n");
Console.WriteLine("'Painting Details:- \n");

Console.WriteLine("Total area: {0}", Rect.getArea());
Console.WriteLine("Total paint cost: ${0}", Rect.getCost(area));
Console.ReadKey();

OUTPUT:
n ° file:///c:fusers/bist/documents/visual studio 2012/Projects/ConsoleApplication2/ConsoleApplicati... {E@&

IMPLEMENTATION OF MULTIPLE INHERITANCE

Total paint cost: $2450

Result:

Thus the program in C# programs inheritance concepts is implemented, executed successfully and the output
is verified
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EXPERIMENT 4.a— OPERATOR OVERLOADING

To develop a console application to implement operator overloading concept in C#

(@) Unary Operator Overloading

(b) Binary Operator Overloading

UNARY OPERATOR OVERLOADING

ALGORITHM

Step 1: Create a new project and a console application in Visual Studio 2012

Step 2: Create a class named “Negate” and declare three variables

Step 3: Write a method to overload minus operator to negate the values given through main method

Step 4: Create objects for negate classes and so that unary minus operator when applied to an object will

change the sign of each of its data items
Step 5: Display the values that are negated
PROGRAM:

namespace ConsoleApplication6

{

class Negate
{
intx,y, z;
public Negate (int a, int b, int ¢)
{
a,
b;
c

X
y
z

}
void display()
{
Console.WriteLine("X={0},y={1},z={2}", x, vy, 2);
}

public static Negate operator -( Negate c)
{

C.X = -C.X;

cy=-Cy;

c.z=-C.z;

return c;

}
public static void Main(string[] args)

{

Console.WriteLine("\t \t Implementation of Unary operator Overloading!! \n ");
COﬂSO|EWI’IteLIne("\t \t ************************************************");
Negate p = new Negate (5,-6, 4);

p.display();

Negate pl = new Negate (5, -6, 4);

pl=-p;

Console.WriteLine("\nNegation is applied to all the values!"\n");

pl.display();

Console.ReadKey();

22




OUTPUT:
B filey//C:/Users/BIST/Documents/Visual Studio 2012/Projects/Consolefpplication1/Consclefpplica... = =] X
Implementation of Unary operator Overloading?t?

30 -JoE 0 -Jof-aE-Jof -Jof e -Jof~af-Jof -af 30 -Jof - Jof -Jof—Jof - Jof 0 -Jof-af-J0f - Jof 0 -Jof~ef-Jof-Jof 30 -Jof~uE-Jof -Jef—Jof-Jof - Jof-ef-Jof-JoE-0E-Jef-oE- -

H=5,y=—6,.z=4

Megation iz applied to all the valuest?

23




4.b.BINARY OPERATOR OVERLOADING

ALGORITHM

Step 1: Create a new project and a console application in Visual Studio 2012

Step 2: Create a class named “complex” and declare real and imaginary values

Step 3: Write a method for overloading (“+”) binary operator and add the real & imaginary values

Step 4: In main method, objects are created for invoking the complex class. The + operator is overloaded to adg
the values in the objects of Complex class

Step5: Display the values of real and imaginary and also the sum of the complex numbers

PROGRAM:
namespace ConsoleApplication4

class Complex

{

decimal X, y;
public Complex()
{

public Complex(decimal real, decimal imag)

{
X =real;
y =imag;

}
public void ShowXY ()
{

Console.WriteLine("The two values are :- \n Real value X = {0} Imaginary value Y = {1} \n", x, y);

public void show()

{
¥

public static Complex operator +(Complex c1, Complex c2)

{
Complex temp = new Complex();
temp.x = c1.x + c2.X;
temp.y = cl.y + c2.y;
return temp;
}

}
class MyClient

{
public static void Main()

{

Console.WriteLine("Addition of complex numbers x(real) + i(imaginary)y is {0} + i{1}", X, y);

Complex c1 = new Complex(10, 20);

Console.WriteLine("\t \t Implementation of Binary operator Overloading!! \n *');
COﬂSO|€WI’IteLIne("\t \t **************************************************");
c1.ShowXY(); // displays 10 & 20

Complex c2 = new Complex(20, 30);

Console.WriteLine(""Now passing two other values \n");

c2.ShowXY(); // displays 20 & 30

Complex ¢3 = new Complex();

c3=cl+c2;
Console.WriteLine("\t \t Overloading binary operator '+' to add two complex numbers \n");
Console.WriteLine("\t \t ");

24




c3.show();
Console.ReadKey();

¥
¥

¥
OUTPUT:

file://CofUsers/BIST/DocumentsMNVisual Studio 2012/Projects/ConsoleApplicationl/Consoclefpplica...
Overloading??

= | = 2

e

m| »

Implementation of Binary operator

The two values are =
Real value X = 18 Imaginary value Y

Mow passing two other values

The two values are =
Real value H = 28 Imaginary value ¥ = 38
Ouerloading binary operator '+ to add two complex numbers

x*Creal?> + idimaginary?y is 38 + i5@

Addition of complex numbers

Result:
Thus the program in C# for operator overloading concepts is implemented, executed successfully and the
output is verified
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EXPERIMENT -5
THREADING

Al

To develop a C# console application to implement threading concepts

ALGORITHM:

Stepl : Create a new project for developing a c# console application using visual studio 2012

Step 2: Create a class called “ThreadClass” inside “namespace -ForegroundThread”

Step3: Create methods to make a thread to sleep, pause and resume using Start, sleep, resume methods
Step 4: create two threads A & B and give highest priority to a thread to make it execute first using
Thread.Priority method

Step 5: Display the thread names which are executing

PROGRAM

using System;

using System.Threading;

using System.Text;

using System.Threading.Tasks;

namespace ConsoleApplicationl

{

class ThreadCreationProgram

{
public static void ChildThread()

{
Console.WriteLine("Child thread starts™);

/I the thread is paused for 5000 milliseconds
int sleepfor = 5000;

Console.WriteLine("Child Thread Paused for {0} seconds", sleepfor / 1000);
Thread.Sleep(sleepfor);
Console.WriteLine("Child thread resumes");

¥

static void Main(string[] args)

{
ThreadStart childref = new ThreadStart(ChildThread);

Console.WriteLine("In Main: Creating the Child thread");

Thread t = new Thread(childref);
t.Start();
Console.ReadKey();

Thread threadA= new Thread(new ThreadStart(ChildThreadA));
/Il Create ThreadB object
Thread threadB= new Thread(new ThreadStart(ChildThreadB));

threadA.Name= "Thread A";
threadB.Name= "Thread B";

26




/I set highest priority of threadB
threadB.Priority= ThreadPriority.Highest;
threadA.Start();
threadB.Start();
Thread.CurrentThread.Name= "Main"";
for (int i=0; i<5; i++)
{
Console.WriteLine(Thread.CurrentThread.Name);

}
Console.ReadKey();

¥
public static void ChildThreadA()

{
for (int i=0; i<3; i++)
{
Console.WriteLine("Child thread A:");
k
}
public static void ChildThreadB()
{
for (int i=0; i<4; i++)
{
Console.WriteLine("Child thread B:");

}
Console.ReadKey();

¥
¥
¥

OuUTPUT

i | file:///C:/Users/BIST/Documents/Visual Studio 2012/Projects/Consclefpplication1/Consclefpplica...

In Main: Creating the Child thread
i thread starts

m [ »

Thread Paused for 5% seconds
thread B:

thread

thread

thread

thread
thread
thread
thread »

Result;

Thus the program in C# for threading concept is implemented, executed successfully and the output is

verified
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EXPERIMENT 6 — DELEGATES & EVENTS

Al

To develop a c# console application to implement the following concepts:
(a) Delegates

(b) Events

() DELEGATES

ALGORITHM
Step 1: Create a new Visual C# project - Console application
Step 2: Create a class named as ‘Ex5’ and declare static variable ‘num’ to retain its value for addition and
multiplication operations
Step 3: Create a delegate named as “NumberChanger” and declare globally
Step 4: Define methods to add and multiply numbers and name it as ‘Addnum” and ‘multnum’
Step 5: In main method, create two objects for delegates as nc1, nc2
Step 6: addnum and multnum methods are passed as arguments within ncl and nc2
Step 7: print the addition and multiplication result
PROGRAM:
namespace ConsoleApplicationl
{
delegate int NumberChange(int n);
class ex5
{
static int num = 10;
public static int addnum(int p)

{

num +=p;
return num;

¥

public static int multnum(int q)
{

num *=q;

return num;

hy

public static int getnum()

{

return num,;

¥

static void Main(string[] args)

{
Console.WriteLine("\t \t Implementation of Delegates!!!");
ConsolewrlteLl ne("\t \t********************************\n");
NumberChange ncl = new NumberChange(addnum);
NumberChange nc2 = new NumberChange(multnum);
ncl(25);
Console.WriteLine("Result of addition is {0}\n", getnum());
nc2(5);
Console.WriteLine("Result of multiplication is {0}", getnum());
Console.ReadKey();

28




Output
1 B filey/f/c/users/bharath univ/documents/visual studio 2012/Projects/Consolefpplication29/Consol... =] O ]

Implementation of Delegatezstt?

Hesult of multiplication is 175
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(b) EVENTS

ALGORITHM

Step 1: Create a new Visual C# project - Console application

Step 2: Create a class named as ‘PROGRAM’ and declare delegate named as ‘DelEventHandler()’
Step 3: Create a new form for the same project by selecting menu - project > Add Windows form - Add and
inherit that form within this code by class Program : Form1

Step 4: insert a textbox and add contents like Event handling program

Step 5: In coding, create a button using button object

Step 5: create an event handling method so that when the button is clicked, it displays a message box
Step 6: Console application displays the message as ‘Event initiated’ when the button event is created
successfully.

Step 7: Save the program and execute!

PROGRAM:

Using System;

using System.Drawing;

using System.Windows.Forms;
namespace ConsoleApplication2

{
public delegate void DelEventHandler();

class Program : Form1
{
/lcustom event
public event DelEventHandler add;

public Program()
{
// desing a button over form
Button btn = new Button();
btn.Parent = this;
btn.Text = "Click Me";
btn.Location = new Point(100, 100);

/[Event handler is assigned to

/I the button click event

btn.Click += new EventHandler(onClcik);
add += new DelEventHandler(Initiate);

/linvoke the event
add();
}
/Icall when event is fired
public void Initiate()
{

Console.WriteLine("Event Initiated");

/lcall when button clicked
public void onClcik(object sender, EventArgs e)

{
30




MessageBox.Show("The Button is clicked sucessfully™);

}

static void Main(string[] args)
{
Application.Run(new Program());
Console.ReadLine();
}
}
}

OUTPUT:

!' = ;i.le:.;';-/c:/users/bist/d.ocu ments/visual studio ‘2V(7)12ﬂ3roiects/ConsoleApplicagonUConsdleApél.iéaﬁ... E=REC
uen 774_——_‘

Click Me

The Button is clicked sucessfully

Result:

Thus the program in C# for delegates and events concepts is implemented, executed successfully and the
output is verified
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EXPERIMENT-/
WINDOWS FORM CONTROL

AIM
To design a window based application using C# code in VB.Net

ALGORITHM
1. Create a new project and select Visual C# - Windows Form application
2. Select controls like labels, buttons, textboxes, picturebox, progressbar etc from toolbox and design a
form based on your application
3. Double click on controls and add necessary C# coding
4. Save and Run the application

PROGRAM

FORML1.CS

using System;

using System.Collections.Generic;
using System.ComponentModel;
using System.Data;

using System.Drawing;

using System.Ling;

using System.Text;

using System.Threading.Tasks;
using System.Windows.Forms;

namespace SWcourses

{

public partial class Form1 : Form

{

Form4 f4 = new Form4();
Form3 3 = new Form3();
Form2 2 = new Form2();
private void linkLabel2_LinkClicked(object sender, LinkLabelLinkClickedEventArgs e)

{
f3.Show();

this.WindowState = FormW,indowState.Minimized;

¥

private void linkLabel3_LinkClicked(object sender, LinkLabelLinkClickedEventArgs €)

{
t4.Show();
this.WindowState = FormWindowState.Minimized;

¥

private void linkLabell_LinkClicked(object sender, LinkLabelLinkClickedEventArgs e)

f2.Show();
this.WindowState = FormWindowState.Minimized;
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FORM2.CS

using System;

using System.Collections.Generic;
using System.ComponentModel;
using System.Data;

using System.Drawing;

using System.Ling;

using System.Text;

using System.Threading.Tasks;
using System.Windows.Forms;

namespace SWcourses

{

public partial class Form2 : Form

public Form2()
{

InitializeComponent();

}

private void buttonl_Click(object sender, EventArgs e)

{

MessageBox.Show("Registration Successful!!, Welcome to our Centre!! All the
Best!");

}

}
}
FORMS3.CS
using System;
using System.Collections.Generic;
using System.ComponentModel;
using System.Data;
using System.Drawing;
using System.Ling;
using System.Text;
using System.Threading.Tasks;
using System.Windows.Forms;
namespace SWcourses

{

public partial class Form3 : Form

{
ProgressBar pBar = new ProgressBar();

public Form3()

InitializeComponent();

¥

private void buttonl_Click(object sender, EventArgs e)
{

progressBarl.Visible = true;
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pBar.Dock = DockStyle.Bottom;
inti;

progressBarl.Minimum = 0;
progressBarl.Maximum = 200;

for (i=0; i <= 200; i++)
{

progressBarl.Value = i;

}
richTextBox1.Visible = true;

}

private void Form3_Load(object sender, EventArgs €)

{
richTextBox1.Visible = false;

progressBarl.Visible = false;

¥
¥
X
OUTPUT

e
o= a =
=Sl
@
.....

=25

2
A
SEED

o
a8
B
o OEasnd
& o
OESSEND
&

¥ ey

New Users

=

Our Students

)8
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a5 About Us

e — s S

Reach Us At:

Janani Software Development Centre
‘No.S, Cross cut Road,

JVSP Colony

Bangalore

Mail Us : ksp@janusw.co.in

1 GO :,:gle

One account. All of
| Google.

Sign in to continue to Gmail

e e K
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Result:

Thus the program in C# for windows form control concept is implemented, executed successfully and the

a Our Students
-

View our courses :-

Priyaa
Tuesday . Apil 03,2018 [@~v

BE

Flat No.3, Petras apartmer

[z Programming Languages

‘... Phython
Bl St Tesing
i~ Manual Testing

= Automation Tools
- Winrunner
i Loadrunner
QTP
i Test Director
- Selenium

[SF Web Development]

>

Register!

Registration Sucessfull!!

output is verified
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EXPERIMENT -8
VALIDATING DATA

AlM
To implement validating data entered in controls using
(a) Windows based application — Manual coding for validation

(b) Web based application — Validation Controls

ALGORITHM

1

2.
3.
4.

1

1
1

. Create a new project - Windows Form application = View - Toolbox

Place 2 Labels, 2 Textboxes and 2 buttons in form

Add error provider control from toolbox in the form to display error during validation

In textbox’s properties, select Error on error provider 1 and type the error msg to be displayed

textBoxMame Systern.Windows. Forrms. TestBon

. . . \hﬂﬂﬂng tBaxMame_Walidatindg |
Select textbox1 and right-click =>properties -

the marked property in the picture and type the coding

Type the coding to validate the data entered in the textboxes.

Save and run the project

Create a new project - ASP.Net Web Application

Click Project > Add New Item ->Web Form -> Add

0. Click Design tab at the bottom of the page and add 6 labels, 5 textboxes, 1 calendar control

1. From toolbox, select validation to see the list of validation controls available

2. Select Required Field validator, compare validator, Range validator and Regular expression validator
controls and place it near textboxes and change properties to display error message as needed

3. Add the following code in .aspx page to allow only alphabets and . for passenger name textbox -
ValidationExpression="[a-zA-Z ]*."

4. Add validation summary control at the end to display all errors in form

5. Save and run in internet explorer or Google chrome

4 WAy ey Rl we] R vl

and double click

PROGRAM
CODE(Windows based application):

private void textBox1_Validating(object sender, CancelEventArgs e)

{
if (string.IsNullOrWhiteSpace(textBox1.Text))

{
e.Cancel = true;
textBox1.Focus();
errorProviderl.SetError(textBox1, "Number should not be left blank!");

¥

else

{

e.Cancel = false;
errorProviderl.SetError(textBox1, "™);

¥
ks
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private void textBox1_KeyPress(object sender, KeyPressEventArgs e)

{
if (System.Text.RegularExpressions.Regex.IsMatch(textBox1.Text, "[*0-9]"))
{
MessageBox.Show("Please enter only numbers.");
textBox1.Text = textBox1.Text.Remove(textBox1.Text.Length - 1);
}
}

OQUTPUT(Windows based application):
ol Online Registration = | S| E—

Aadhar card number O

Citizen name [ Mumber should not be left blank! }

[ Ok | [ caneat |
! Online Registration == L
Aadhar card number F QO ‘
Citizen name
Please enter only numbers.
[ Ok | [ canceal |
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=

-l Online Registration

L= [ |

Aadhar card number

Citizen name

56456456

Priva

Qe

J [

Cancel

Result:

Thus the program in C# for validating data is implemented, executed successfully and the output is verified
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EXPERIMENT -9

CUSTOM DIALOG BOX & MDI APPLICATION

AlM
To design a notepad application to implement menus, custom dialog box and MDI concepts

ALGORITHM
1. Create a new project - Visual C# - Windows application

2. From Toolbox, include Richtextbox, Menustrip , Color dialog, Font dialog, OpenFileDialog and
savefiledialog controls

3. After including menustrip controls, type the required menus like File,new,open,save,
Edit,cut,copy,paste, clear, format, font,color,help

4. Forml ->Rich text box and menus , Form2 - Custom Dialogbox and Form3 —> Include richtextbox and
webbrowser control

5. Double-click menu items and add the code

6. Click Project->Add item ->Windows form and insert rich text box and web browser controls and type
webaddress in URL property of webbrowser control

7. Click Form1->properties-.IsMDIContainer property ->set to true
8. In Form1->Window state property - Maximized
9. Select richtextbox in form1 and form3 and select its property ‘Dock’ and select top/bottom

10. In Form2->include label and 2 buttons and Select the form and change its properties
—>FormBorderStyle>select as Fixed Dialog to create a custom dialog box

PROGRAM
using System;
using System.Windows.Forms;

namespace WindowsFormsApplication11

{

public partial class Form1 : Form

{
public Form1()

{
k

private void openToolStripMenultem_Click(object sender, EventArgs e)

{
OpenFileDialog dlg = new OpenFileDialog();

dlg.ShowDialog();

InitializeComponent();

if (dlg.ShowDialog() == DialogResult.OK)
{
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string fileName;
fileName = dlg.FileName;
MessageBox.Show(fileName);
}
}

private void colorToolStripMenultem_Click(object sender, EventArgs e)
{

ColorDialog dlg = new ColorDialog();

dlg.ShowDialog();

richTextBox1.ForeColor = dlg.Color;
}

private void fontToolStripMenultem_Click(object sender, EventArgs e)

{

FontDialog fdlg = new FontDialog();
fdlg.ShowDialog();
richTextBox1.Font = fdlg.Font;

}

private void exitToolStripMenultem_Click(object sender, EventArgs e)
{

PrintDialog dlg = new PrintDialog();

dlg.ShowDialog();

by

private void saveToolStripMenultem_Click(object sender, EventArgs e)
{

SaveFileDialog sfdlg = new SaveFileDialog();

sfdlg.Filter = "Text Files (*.txt) | *.txt";

string Saved_File =" ",

saveFileDialogl.InitialDirectory = "C:";

saveFileDialogl.FileName = "";

if (sfdlg.ShowDialog() == DialogResult.OK)

{

Saved_File = saveFileDialogl.FileName;
richTextBox1.SaveFile(Saved File, RichTextBoxStreamType.RichText);

k
¥

Form2 f2 = new Form2();
private void deleteToolStripMenultem_Click(object sender, EventArgs €)

f2.Show();

DialogResult res = MessageBox.Show("Are you sure you want to Delete",
"Confirmation", MessageBoxButtons.OKCancel, MessageBoxIcon.Information);
if (res == DialogResult.OK)

{

MessageBox.Show(*"Are you sure? ");
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//Some task...

¥

if (res == DialogResult.Cancel)

this.Close();
//Some task...

k
k

private void copyToolStripMenultem_Click(object sender, EventArgs e)

{
richTextBox1.Copy();

ks

private void clearToolStripMenultem_Click(object sender, EventArgs e)

{
richTextBox1.Text="";

Clipboard.Clear();
}

private void pasteToolStripMenultem_Click(object sender, EventArgs e)

{
richTextBox1.Paste();

}
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OUTPUT
Notepad with menus

sl My Notepad Application

File Edit Format Help

o5l My Notepad Application

- o0 & * (=]

File | Edit Format Help

| MNew

| Open |

Save
Print
Exit

o5l My Notepad Application

2 o® 5 ® E=R R

File | Edit | Format Help

Cut

Copy
| Paste |

Clear
Delete
Undo

[

o) My Notepad Application

- = | &

File Edit | Format | Help

Font

I Color I

Font Dialog Box

sE My Notepad Application P — | = | = = |
-—
File Edit Format Help
This is mmy notepad application =
Font |
Created using C#-Dotnst  in Visual Studic 2012
Fort:

Modem Mo. 20

FiaZand

Afonotyps Corsiva
MS Outlook

Microsoft Sans Sernf =

Riodern o 20 |88

Effects
] Strikeout
[ Underdine
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Ll MMy Notepad Application

—— | = = = |
File Edit Format Help:
This is my notepad application =
Font Il
Created using C#-Dotnet  in Misual Studic 2012
Fort: Fort style: Size
Modem MNo. 20 Eold L oK 1
Microsoft Sans Serif = Begnlar = g =
Fostaad Obligme S
C=raammm | |z
Aromoype Corsiva = Bold Obligme .BE
MS Cutlook - - | == ~

Effects
[ Strikkeout

) Gt AaBbY

Sample

Script:
Westem —
BE My RMotepad application — - N - S =y gy ——
File Eait Format Help

"MThis 1s TMmy mnmotepad application

Created using CF- 1Dotmnet iTn W
Studio 20122

Custom Dialog Box

"8 My Notepad Application e

= =l
Delete DialogBox J

istpaal

| oK | { confirmation =S

4/7;
\0\, Are you sure you want to Delete
wr

[ oK ] [ canca |

MDI Application
a5/ My Notepad Application - [MDI o

Google H

‘ Advanced search
Language tools

Google Search ‘ I'm Feeling Lucky ‘

This is a sample MDI application. It gets opened within the main form itself instead of opening as a
new form window!!

Result:

Thus the program in C# for custom dialog box and MDI is implemented, executed successfully and the outpu
is verified
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EXPERIMENT —10
RETRIEVING DATA FROM DATABASE & WORKING WITH DISCONNECTED

ENVIRONMENT

AIM
To design windows based application to retrieve data from SQL database and to work with disconnected
environment in ADO.Net using C#
ALGORITHM
e Create a new project - Windows Application >Name ok

e Design your form with necessary labels and pictures
e From toolbox, select “DatagridView” control and place it in form

e Select Add project Data Source from this:

s

ol Form3 o o || = || ER
o U DataGridView Tasks

Choose Data Source: mg

Eq{ |@ None
. ¥ Other Data Sources

C Ac
v

J

Cr W

. -
B Add Project Data Source...

Select a data source under 'Other Data
Sources' to connect to data.

e Select database and select dataset, click next, click new connection and click change button and select
Microsoft SQL Server Compact 4.0 - ok button

e Click browse button and select Northwind and select open button

e Click Test connection button and click ok

e Select Next = Yes button

e Double-click Tables folder to view the list of tables available for the northwind database

e Check products checkbox and uncheck all other checkbox to display products table in the windows
form

e Click Finish button and select Add query button from this page:
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5! Form3 _ T

DataGridView Tasks

Choose Data Source: |[ipar e = |

Edit Columns...
Add Column...
Enable Adding

Product 1D

Supplier 1D

/ Enable Editing
1 [Lm 3

Enable Deleting
Enable Column Reordering

Dock in Parent Container
Add Query...

Preview Data...

e Click Query Builder button - Execute Query - Ok -0k button
¢ Run the application

PROGRAM
Forml Coding

private void buttonl_Click(object sender, EventArgs e)
{
Form2 f2 = new Form2();
f2.Show();
}
Form2 Coding:
private void Form2_Load(object sender, EventArgs e)

{

this.productsTableAdapter.Fill(this.ex10.Products);

¥
OUTPUT

(e IE =]

a5 My Business Products!!
> ; —— —

Round Swamp Farm  Market & Bake Shop

Round Swan
Farm
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Result:

Thus the program in SQL for retrieving database application is implemented, executed successfully and the
output is verified
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